Manifest destiny for all of the Americas, and especially for the vast lands that were included in Jefferson’s great purchase from Napoleon and that continually haunted his own French and Rousseau-like thinking, has continually presented a fascinating face in terms of labeling and terminology as well as in the tonal uses of language both as a tool for progress and as veil or mask for concealment. I open this paper with a convoluted sentence for a very German and Romantic notion: the West. Biographies of Adolf Hitler suggest that even he loved to read American Westerns in translation as well as the German imitators of our westerns; and his obsessive drive for *lebensraum* seems almost quintessentially American (Toland). But putting political correctness and moral concerns aside for the moment – if that can at all be done with good conscience here in New York City only three years after 9/11 – the historical and political tension used to talk about “American Empire” from Jefferson and Alexander von Humboldt onward until our century, by which I mean still the 20th century, also tells us much about epistemology and the practical implications of exploratory science and scientific exploration as a whole and unified enterprise.

I shall get to the seminal old writers here, but it is the wonderful analysis of tone and of tension in matters of race and Empire in Kurt Vonnegut’s *Breakfast of Champions* (1973) where I want to begin. At the start of the book, he says, “color is everything” and then moves to insist that all his analysis of imperial American history will be “impolite.” At the same time, he argues how “astonishing” the West and western expansion was in history (preface and chapter 1). This opening rant in Vonnegut’s novel is a great boasting contest just as it is brash and, indeed, impolite. So a good western (with an uppercase “W” perhaps), the tall tale that Mark Twain had mastered, is recreated in this Vonnegut book; and clearly for him this writing represents
the old dilemma of the “neo-classic,” januslike two-facedness. He celebrates
what is truly new, and wants to be new himself in tone and narrative struc-
ture, but he also is haunted by the old “classes” just as America itself from
the beginnings has been haunted by color.

My two concrete examples in this short paper about the origins of this
Vonnegut ambivalence of tone come from early writing about the West done
by very hands-on explorers and travelers who kept evoking their “classic”
European roots even as both of them were forging new texts with writing
implements in their great canoes or in field tents. But the spirit of such neo-
classic language use at the time, also, can be seen as a sort of umbrella effect
arching over these bug-infested and practical writings; and the umbrellas
came from the most metropolitan salons and lecture halls of the East and of
Europe. Our great Thomas Jefferson and the Baron von Humboldt himself
were using language in this same ambivalent and neo-classic way and so
must have been, in part, the authorities or authors who were granting the lan-
guage license to the voyageurs, the explorers, the military men in the field.
Further, I speculate that even up to our present day in space exploration and
planet talk – and, indeed, with Antarctic exploration where Robert Falcon
Scott took Browning with him to read as he froze to death in his tent located
nicely midway between Jefferson and today – one can discover and appreci-
ate a similar neo-classic tension reflected clearly in the language employed.
We are humans always in our tentativeness as we forge onward and look
backward at the same time. But space language and the language of the great
journeys South must remain material for other papers even though I may sug-
gest that the astonishing similarities in language usage rivet home my key
term here: the neo-classic.

Strangely, my first example comes from a text written by the young Major
George Washington who was later to become, of course, the legendary East
coast umbrella for such circumspect language used to govern these tensions
in conceptualizing. Washington’s language, in fact, was such a mask that we
often cannot even be certain that the language is his own. The recent Ron
Chernow biography of Alexander Hamilton documents neo-classic ambiva-
lence wonderfully, and we learn there again that Hamilton probably wrote
many of Washington’s later phrases that ring with a measured ambivalence
about “the people” and about “newness.” In fact, the key concept in this neo-
classic effect is the notion of “circumspection” where the word itself embod-
ies in its Latin clarity the value of “seeing around,” of vision that may look
backward and forward at the same time. And such thoughtful circumspection
always seems to have been stimulated by the astonishing confrontation with
things “western,” with the new.
It may just be Empire building that is so astonishing and so conducive of ambivalence in tone and expression because I think we see it even in Vergil in the famous tag line *Tantae molis erat Romanum condere gentum* – “How hard it was to found the race of Rome” (Bk one, line 33). Here the image “tantae molis” literally means “how great small pieces” since “molis” eventually was to become our word “molecule.” In any case, it is not just the old Latin, which I believe Washington like Shakespeare had little of, but also the delicate and circumspect that we can sense as Washington writes about the Ohio country of western Pennsylvania as a young major. In another sense, this is the driving American business language too where the aggression and conflict of continual flux and possibility for newness must be a beast that can only be tamed by contractual balance. My point is that such “contracts” characteristically include neo-classic ambivalence and, often, even Latinate cement laid on top of the other language characteristics that are more goth and new. Here is Washington speaking about his negotiations and translation experiences with a myriad of Indian factions, all of which language usage gets nicely generalized under the rubrics of “father to child.” Washington is quoting a chief called “Half-King” and so, of course, translating:

Fathers, I am come to tell you your own Speeches: what your own Mouths have declared...And if I your Father, should get foolish in my old Days, I desire you may use it [a rod] upon me as well as others. (7)

The concealed truth beneath the narrative language rubrics is later revealed so starkly in a letter dated 7 September 1783 when the older Washington peels back his circumspection and writes:

...[to move the Indian by force] is like driving the Wild Beasts of the Forest which will return as the pursuit is at an end and fall perhaps on those that are left there; when the gradual extension of our Settlements will as certainly cause the Savage as the Wolf to retire; both being beasts of prey tho’ they differ in shape. (266)

So Washington was, indeed, circumspect about his deep and harsh perception of the native Americans he knew.

My favorite example for this short paper is not a “great” at all in our current collective memory. Unlike Washington and Jefferson and Humboldt, Henry Rowe Schoolcraft has nearly been forgotten even though Michigan State University has recently embarked on a nice publishing project to save his massive ethnographic and travel writings about the West. I suggest, however, that Schoolcraft himself as a writer fully anticipated the drowning into a sort of anonymity for his career; and such “sad” anticipation, indeed, emerges in the mind of any writer as he or she becomes nearly “silent on a peak in Darien,” in the face of Western Empire. Then, as in Keats, the astonishing awesomeness of the newness produces convolutions in language. Actually, I
myself again anticipate the general in the presence of massive and astonishing particularities of text. Schoolcraft wrote a lot about the Indians, about his travels across the upper reaches of the old Michigan territory, about the languages themselves of the natives that he had begun to learn and to categorize. He liked to chop up word particulars and to reassemble the parts into new labels, new concepts, new substantives. And most everything new that he saw and that he made in his new science of ethnography and in his new geography had in it the stamp of the old, even the European.

Some commentators on Schoolcraft see him at times as resembling the great natural shape-shifters personified in the Algic folktales and legends that he collected and translated when he worked as Indian Agent in upper Michigan. He reinvented and changed himself as an American writer several times from 1818, when he came west from New York state, until his death in the final year of the Civil War. Also, in the later 19th century he was viewed, in part, as a writer of children’s fairy stories; and now, in recent decades, his work has come to be seen as seminal both to modern ethnographic research and to the history of American writers attempting to find a voice as Americans. Like the Northwest Territories themselves, his work was both on the fringe as well as characteristic of a sort of Emersonian self-reliance and stubbornness in the effort to define his own voice. His was a quest of an American scholar, and he was continually conflicted as a writer. His material was distinctly American; and his shape-shifting was as insecure, suspect, and as immensely fertile as the rest of the expanding nation in the early 19th century. A century after his death, scholars began to identify and to describe these qualities in what Schoolcraft wrote about the Northwest Territories, especially the Lake Superior region and northern Minnesota and the shifting populations of natives that explorers found there, interacted with, and eventually remade for their own purposes.

Schoolcraft’s roots, however, were in the East. He had the rudiments of a classical education in his hometown of Hamilton, New York, in preparation for entering Union College. But he had to go to work instead. Later, he did attend Middlebury College briefly and published poetry as a young man. Whenever he traveled in the West, he tried to purchase books through agents in Detroit and to maintain his book collection. A dissertation on his writing done nearly 200 years after his birth finds, “Books were a part of his life in which he never lost interest even when he moved to the frontier” (Mosser, 23). And so, as we shall see, he made good use of his language and classical studies to highlight some of his best investigative work and ideas.

Schoolcraft the writer can be sensed fully operative alongside his seminal work as ethnographic researcher and even as geographic explorer. One of his later expeditions in the big canoes west that took place in 1832, with the
blessing again of Governor Cass of the Territory, moved from the Sault westward and resulted in Schoolcraft’s key discovery of the source of the Mississippi at Lake Itasca in Minnesota. Schoolcraft renamed the lake from earlier “mooselike” names that the trappers had used, and when he did so he used his Latin training as follows: “...he took the name from the Latin words *veritas caput*” (Mason, xxiv). The Latin means “true head,” and what is fascinating is the Schoolcraft habit of chopping a few letters from the body of the phrase in order to coin a new work – *Itasca*. He does something very similar with language in his Indian studies when he attempts to categorize the related tribes that he finds linked by language and storytelling. “In 1832 he founded the Algic Society – the first use of his neologism that combined “Algonquin” and “Atlantic” (Algic, xi). Further, when he writes about his most famous story character Manabozho, who becomes Longfellow’s Hiawatha, the tone of slight irony he uses resounds with the literary training that permits Schoolcraft the distinct sensibility to appreciate what he has uncovered in his investigations and yet to show a writer’s voice, and a Christian voice, of interpretation. He writes:

…as Manabozho exercises powers and performs exploits wild or wonderful, the chain of narration which connects them is broken or vague. He leaps over extensive regions of country [and presumably of narration] like an ‘*ignis fatuus*’ (Algic, 51).

Thus, a somewhat ironic and detached rational voice, which uses alien Latin reference, emerges in the mass of Algic materials that were originally published by Schoolcraft the Indian Agent. This voice has classical echoes as well as echoes from the investigators of the Enlightenment whom Schoolcraft must have included among his collections of books. Again, from the Algic researches prefatory material, he sounds almost like an eighteenth-century numismatic collector of Roman coins, “Words are like coins, and may, like them be examined to illustrate history” (Algic, xxxiv). He recorded many of these words from the extended family of his Ojibway wife, but he also coined them (and “Englished” them) as though he were chopping up Latin. Hence, in addition to his large label “Algic,” which he coined, other labels for parts of the network of tribes spanning the eastern half of the continent spice up his narratives: “Ostic” for one group, “Abanic” for another. Schoolcraft said that he Englished these terms from native words, but many he coined from chopped-up pieces where we hear the “ic” tag derived from the word “Atlantic” at the close of several.

Finally, a short letter from Thomas Jefferson to Humboldt himself embodies the several ambivalences presented by the “astonishing” West and, at the highest level, may serve to demonstrate how the neo-classic sense of linking the old with the awesome “new” was a key language device used to clothe
these ambivalences. Jefferson writes to the Baron in the year just before Schoolcraft went West from New York state, the year 1817, and it seems to be the enigma of Spain that figures here the tension between what is new and being born with what we are used to as old. Three sentences from this letter, with one Latin tag:

Whether the blinds of bigotry, the shackles of the priesthood…give fair play to the common sense of the mass of the people, so far as to qualify them for self-government, is what we do not know. Perhaps our wishes may be stronger than our hopes. The first principle of republicanism is, that the “lex majoris parties” is the fundamental law of every society…yet the last which is thoroughly learnt. (681)

Jeffersonianism has prevailed, and the “majority party” nearly always wins out even if that party happens to be National Socialism or the Franco party of modern Spain. Ambivalences continue.

Bibliography

Nomenclature entries can be added using Insert→Nomenclature Entry or using the appropriate button on the toolbar. This will bring up a dialogue box which wants the symbol as it is to appear, a description and a sort as a key. Often you will want the symbol to appear as it does in an equation in which case you should surround it by dollar signs ($Symbol$). You should be able to copy and paste the symbol directly from a LyX equation, which could be useful if you are unsure of the LaTeX codes for Greek letters or subscripts. For further documentation see Help→Additional Features (in 2.0.0, Help→Use Hence, this backwards exploration of open-start type will in general require additional information on potential reagents and catalysts that can promote the forward reaction. The machine-learning based retrosynthesis algorithms mentioned in the Introduction.

Figure 1 Three principal exploration types. Top: forward open-end (FOE) exploration; middle: backward open-start (BOS) exploration; bottom: start-to-end (STE) exploration. Starting material (initial reactants) are given on the left-hand side and are typically of small molar nomenclature where eq is the number of the last equation in front of the corresponding command \nomenclature. norefeq No equation reference is printed. (default) refpage The phrase â€œpage page â€ is appended to every entry in the nomenclature where page is the number of the page on which the corresponding command \nomenclature appeared. norefpage No page reference is printed. (default) prex Every sort key. Â· notintoc No entry for the nomenclature in the Table of Contents. (default). tocbasic Use tocbasic package from KOMA script bundle for TOC handling (default). notocbasic Do not use tocbasic package from KOMA script. This new edition brings the classic work back to life. In the late eighteenth century, mineralogist Abraham Gottlob Werner devised a standardized color scheme that allowed him to describe even the slightest of chromatic differences with consistent terminology. His scheme was then adapted by an Edinburgh flower painter, Patrick Syme, who used the actual minerals described by Werner to create the color charts in the book, enhancing them with examples from flora and fauna. Â· Werner's Nomenclature of Colours is a charming artifact from the golden age of natural history and global exploration. This beautiful pocket-size facsimile is certain to delight and inform a new generation of artists and scientists. The naming of elements had been traditionally been the privilege of the discoverer and the suggested name was ratified by the IUPAC. In recent years this has led to some controversy. The new elements with very high atomic numbrs are so unstable that only minute, quantities, sometimes only a few atoms of them are obtained. Their synthesis and characterisation, therefore, require highly sophisticated costly equipment and laboratory. scientists, before collecting reliable data on the new element, at